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Υπεύθυνη Δήλωση Φοιτητή 

Βεβαιώνω  ότι  είμαι  συγγραφέας  αυτής  της  εργασίας  και  ότι  κάθε  βοήθεια  την  οποία  είχα  για  την

προετοιμασία της είναι πλήρως αναγνωρισμένη και αναφέρεται στην εργασία. Επίσης έχω αναφέρει τις

όποιες πηγές από τις οποίες έκανα χρήση δεδομένων, ιδεών ή λέξεων, είτε αυτές αναφέρονται ακριβώς

είτε παραφρασμένες. Επίσης βεβαιώνω ότι αυτή η εργασία προετοιμάστηκε από εμένα προσωπικά ειδικά

για τη συγκεκριμένη εργασία. 

Η  έγκριση  της  Διπλωματικής  Εργασίας  από  το  Τμήμα  Πολιτικών  Μηχανικών  του  Πανεπιστημίου

Πελοποννήσου δεν υποδηλώνει απαραιτήτως και αποδοχή των απόψεων του συγγραφέα εκ μέρους του

Τμήματος.

Η παρούσα εργασία αποτελεί πνευματική ιδιοκτησία του φοιτητή Δημήτρη Βλάχου που την εκπόνησε. Στο

πλαίσιο  της  πολιτικής  ανοικτής  πρόσβασης  ο  συγγραφέας/δημιουργός  εκχωρεί  στο  Πανεπιστήμιο

Πελοποννήσου, μη αποκλειστική άδεια χρήσης του δικαιώματος αναπαραγωγής, προσαρμογής, δημόσιου

δανεισμού, παρουσίασης στο κοινό και ψηφιακής διάχυσής τους διεθνώς, σε ηλεκτρονική μορφή και σε

οποιοδήποτε μέσο, για διδακτικούς και ερευνητικούς σκοπούς, άνευ ανταλλάγματος και για όλο το χρόνο

διάρκειας  των δικαιωμάτων πνευματικής  ιδιοκτησίας.  Η ανοικτή  πρόσβαση στο  πλήρες  κείμενο  για

μελέτη  και  ανάγνωση  δεν  σημαίνει  καθ’ οιονδήποτε  τρόπο  παραχώρηση  δικαιωμάτων  διανοητικής

ιδιοκτησίας του συγγραφέα/δημιουργού ούτε επιτρέπει την αναπαραγωγή,  αναδημοσίευση, αντιγραφή,

αποθήκευση,  πώληση,  εμπορική  χρήση,  μετάδοση,  διανομή,  έκδοση,  εκτέλεση,  «μεταφόρτωση»

(downloading), «ανάρτηση» (uploading), μετάφραση, τροποποίηση με οποιονδήποτε τρόπο, τμηματικά ή

περιληπτικά της εργασίας, χωρίς τη ρητή προηγούμενη έγγραφη συναίνεση του συγγραφέα/δημιουργού. Ο

συγγραφέας/δημιουργός διατηρεί το σύνολο των ηθικών και περιουσιακών του δικαιωμάτων. 
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ΠΕΡΙΛΗΨΗ

Η παρούσα Διπλωματική Εργασία έχει κεντρικό θέμα την μελέτη της ροής στην περιοχή της στένωσης

δύο ανοικτών αγωγών ορθογωνικής διατομής, με την αριθμητική προσομοίωση τμήματος των αγωγών

100 και  700 μέτρων μέσω του  υδραυλικού λογισμικού  HEC-RAS,  μελετώντας  το  κρίσιμο βάθος.

Αρχικά παρατίθενται γενικές γνώσεις για τους ανοικτούς αγωγούς, τη στένωσή τους ,το θεωρητικό

υπόβαθρο του HEC-RAS με τις βασικές εξισώσεις που ακολουθεί και στη συνέχεια ακολουθεί μελέτη

πάνω στους ανοικτούς αγωγούς που προαναφέρθηκαν.

Το κάθε σενάριο αναλύθηκε με βάση τα υδραυλικά στοιχεία, όπως η ταχύτητα και το βάθος ροής, ο

αριθμός Froude της ροής, η γραμμή ενέργειας, οι ενδιάμεσες διατομές, ο τύπος ροής και στη συνέχεια

έγινε σύγκριση μεταξύ των σεναρίων. 

Στο πρώτο Σενάριο αγωγού ορθογωνικής διατομής 100m, οι ταχύτητες ροής παρέμειναν χαμηλές και

το βάθος ροής παρέμεινε ίδιο σε όλη τη διατομή. Η γραμμή ενέργειας ήταν πολύ ομαλή. 

Στο δεύτερο Σενάριο αγωγού ορθογωνικής διατομής μήκους 100m (η ροή ξεκινάει από δεξιά πρός

αριστερά δηλαδή από το 100 προς το 0) αρχίζει στένωση στα 60m από το τέλος του αγωγού μέχρι τα

40m , η ταχύτητα ροής άρχισε να αυξάνεται στα 60m από το τέλος του αγωγού λόγω της στένωσης και

στην έξοδο της μειώθηκε καταλήγοντας στην ίδια ταχύτητα ροής του πρώτου σεναρίου. Παρατηρείται

υδραυλικό άλμα στη στένωση.  Το βάθος ροής  μειώθηκε σημαντικά στη στένωση και στη συνέχεια

επέστρεψε  στο  ίδιο  βάθος ροής  του πρώτου σεναρίου μετά την έξοδο της. Η γραμμή ενέργειας

αυξομειώθηκε σχετικά ομαλά. 

Στο τρίτο Σενάριο αγωγού ορθογωνικής διατομής 700m, οι ταχύτητες ροής παρέμειναν χαμηλές και το

βάθος ροής παρέμεινε ίδιο σε όλη τη διατομή. Η γραμμή ενέργειας είχε ήπια κλίση. 

Στο τέταρτο Σενάριο αγωγού ορθογωνικής διατομής 700m (η ροή ξεκινάει από δεξιά πρός αριστερά

δηλαδή από το 700 προς το 0) αρχίζει στένωση στα 400m από το τέλος του αγωγού μέχρι τα 300m , η

ταχύτητα ροής άρχισε να αυξάνεται στα 400m, από το τέλος του αγωγού, λόγω της στένωσης και στην

έξοδο  της  μειώθηκε  καταλήγοντας  στην  ίδια  ταχύτητα  ροής  του  τρίτου  σεναρίου.  Παρατηρείται

υδραυλικό άλμα στη στένωση.  
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Το βάθος ροής μειώθηκε σημαντικά στη στένωση και στη συνέχεια επέστρεψε  στο  ίδιο  βάθος ροής

του τρίτου σεναρίου μετά την έξοδο της. Η γραμμή ενέργειας αυξομειώθηκε σχετικά ομαλά. 

Στο πέμπτο Σενάριο αγωγού ορθογωνικής διατομής 700m (η ροή ξεκινάει από δεξιά πρός αριστερά

δηλαδή από το 700 προς το 0) περιέχονται τρεις διαδοχικές στενώσεις ξεκινώντας η πρώτη στα 600m

μέχρι  τα  500m, η δεύτερη στα 400m μέχρι  τα  300m και  η  τρίτη από τα 200m μέχρι  τα 100m

αντίστοιχα. Η ταχύτητα ροής άρχισε να αυξάνεται στα 600m, στα 400m και στα 200m από το τέλος

του αγωγού λόγω της στένωσης και στην έξοδο τους μειωνόταν μέχρι την επόμενη στένωση ή μέχρι

την  κατάληξη  του  αγωγού  με  τελική  ταχύτητα  ροής  ίδιας  με  αυτής  του  τρίτου  σεναρίου.

Παρατηρούνται  τρία  υδραυλικά  άλματα,  ένα  σε  κάθε  στένωση.  Το  βάθος  ροής  αυξομειώθηκε

σημαντικά στις στενώσεις και στις εξόδους τους και μετά την τελευταία έξοδο στένωσης κατέληξε στο

ίδιο βάθος ροής του τρίτου σεναρίου. Η γραμμή ενέργειας αυξομειώθηκε σχετικά ομαλά. 

Λέξεις κλειδιά : ανοικτός αγωγός,  στένωση αγωγού,  HEC-RAS,  μονοδιάστατη ανάλυση,  υδραυλικό
άλμα
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ABSTRACT

This thesis focuses on the narrowing of two open rectangular channels by performing a numerical sim-

ulation of river sections 100 and 700 meters long using the hydraulic software HEC-RAS, studying the

critical depth. Initially, general knowledge about open channels, their narrowing, and the theoretical

background of HEC-RAS with its fundamental equations are presented, followed by a study on the

aforementioned open channels.

Each scenario was analyzed based on hydraulic parameters such as flow velocity and depth, Froude

number, energy grade line, intermediate cross-sections, and flow type, followed by a comparison be-

tween the scenarios.

In the first scenario of a 100m rectangular channel, the flow velocities remained low and the flow depth

remained constant throughout the section. The energy grade line was very smooth.

In the second scenario of a 100m rectangular channel (flow starts from right to left, i.e., from 100 to 0),

narrowing begins from 60m to 40m from the end of the channel. The flow velocity began to increase at

60m from the end of the channel due to the narrowing and decreased at the exit, ending with the same

flow velocity as in the first scenario. A hydraulic jump is observed at the narrowing. The flow depth

significantly decreased at the narrowing and then returned to the same flow depth as the first scenario

after the exit. The energy grade line fluctuated relatively smoothly.

In the third scenario of a 700m rectangular channel, the flow velocities remained low, and the flow

depth remained constant throughout the section. The energy grade line had a gentle slope.

In the fourth scenario of a 700m rectangular channel (flow starts from right to left, from 700 to 0), nar-

rowing begins from 400m to 300m from the end of the channel. The flow velocity began to increase at

400m from the end of the channel due to the narrowing and decreased at the exit, ending with the same

flow velocity as in the third scenario. A hydraulic jump is observed at the narrowing. The flow depth

significantly decreased at the narrowing and then returned to the same flow depth as the third scenario

after the exit. The energy grade line fluctuated relatively smoothly.
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In the fifth scenario of a 700m rectangular channel (flow starts from right to left, from 700 to 0), there

are three successive narrowings starting from 600m to 500m, from 400m to 300m, and from 200m to

100m, respectively. The flow velocity began to increase at 600m, 400m, and 200m from the end of the

channel due to the narrowing and decreased at the exits until the next narrowing or the end of the chan-

nel, ending with the same flow velocity as in the third scenario. Three hydraulic jumps are observed,

one at each narrowing. The flow depth fluctuated significantly at the narrowings and their exits and, af-

ter the last narrowing exit, ended at the same flow depth as in the third scenario. The energy grade line

fluctuated relatively smoothly.
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ΚΕΦΑΛΑΙΟ 1: ΑΝΟΙΚΤΟΣ ΑΓΩΓΟΣ

Η Υδραυλική των ανοικτών αγωγών είναι ένα πεδίο της Υδραυλικής που μελετά τη ροή του νερού σε

ανοικτούς αγωγούς. Ένας αγωγός θεωρείται ανοικτός ή ελεύθερης ροής όταν το νερό ρέει με ελεύθερη

επιφάνεια, στην οποία η πίεση είναι ίση με την ατμοσφαιρική. Η κύρια δύναμη που κινεί το νερό είναι

η βαρύτητα, ενώ η επιβράδυνση της ροής προκαλείται από τις δυνάμεις τριβής.Οι  ανοικτοί αγωγοί

διαφέρουν από τους κλειστούς αγωγούς, στους οποίους το νερό γεμίζει πλήρως τη διατομή του σωλήνα

και  κινείται  υπό  πίεση.Υπάρχει  μεγάλη  ποικιλία  ανοικτών αγωγών.  Σε  αυτούς  περιλαμβάνονται

μεγάλα ποτάμια, ρυάκια, υδραυλικά κανάλια, διώρυγες ορθογωνικής και τραπεζοειδούς διατομής (βλ.

π.χ.  Δημητρακόπουλος,  2018)  και  δίκτυα  αποχέτευσης  ομβρίων  υδάτων  (βλ.  π.χ.  Λαγγούσης  και

Φουρνιώτης, 2020). Αυτοί οι αγωγοί χωρίζονται σε φυσικούς και τεχνητούς:

• Φυσικοί  αγωγοί:  Αυτοί  δημιουργούνται  από  φυσικές  διαδικασίες  και  δεν  έχουν  δεχθεί

σημαντικές ανθρώπινες επεμβάσεις. Παραδείγματα είναι ποτάμια, χείμαρροι και γενικά όλα τα

φυσικά ρέματα. Η μορφή και το μέγεθος της διατομής τους είναι ακανόνιστα. Η τραχύτητα των

τοιχωμάτων  ποικίλλει  και  συχνά  παρουσιάζουν  αστάθεια  στην  υφή  του  πυθμένα  και  των

πλευρών τους, καθώς και αλλαγές με την πάροδο του χρόνου.

               

Εικόνα 1.1.  Ποταμός Soča, ρέει στη Σλοβενία και στη βορειοανατολική Ιταλία (www.perierga.gr,
2013)
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• Τεχνητοί αγωγοί: Αυτοί κατασκευάζονται ή διαμορφώνονται από τον άνθρωπο. Παραδείγματα

περιλαμβάνουν διώρυγες, αρδευτικά κανάλια, στραγγιστικές τάφρους, καθώς και σήραγγες και

υπονόμους όταν η διατομή τους δεν είναι πλήρης. Η διατομή τους μπορεί να είναι ορθογωνική,

τραπεζοειδής, τριγωνική, κυκλική, ωοειδής κλπ.

Ένας  τεχνητός  αγωγός  χαρακτηρίζεται  αυστηρά ως  πρισματικός  όταν η  διατομή και  η  κλίση του

παραμένουν σταθερές σε όλο του το μήκος. Μπορεί επίσης να είναι κατά τμήματα πρισματικός, αν

αποτελείται από ευθύγραμμα τμήματα με σταθερή διατομή αλλά διαφορετική κλίση κατά μήκος. Σε

όλες τις  άλλες περιπτώσεις,  ο αγωγός θεωρείται μη πρισματικός.  Αυτοί οι  μη πρισματικοί αγωγοί

διακρίνονται σε εκείνους των οποίων ο άξονας είναι πάντα στο ίδιο κατακόρυφο επίπεδο και σε αυτούς

που εμφανίζουν καμπυλότητα στο οριζόντιο επίπεδο.

Εικόνα 1.2. Αρδευτικό κανάλι (www.imerisia-ver.gr, 2020)
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ΚΕΦΑΛΑΙΟ 2: ΣΤΕΝΩΣΗ

2.1 Γενικές πληροφορίες

Η υδραυλική στένωση ενός αγωγού αναφέρεται στη μείωση της διατoμής τoυ αγωγού που προκαλεί

αύξηση της ταχύτητας τoυ ρευστού και αντίστoιχα αύξηση της υδραυλικής πίεσης και απώλειες πίεσης

λόγω τριβών και άλλων φαινoμένων. 

Η στένωση μπoρεί να oφείλεται σε διάφορους λόγoυς, όπως:

• Μηχανικές κατασκευές: Πρoβλέπεται σκόπιμα σε σχεδιασμό συστημάτων για έλεγχο της ρoής

ή αύξηση της πίεσης.

• Εναπόθεση υλικών: Μπορεί να συμβεί λόγω εναπόθεσης αλάτων, σκoυριάς ή άλλων στερεών

μέσα στoν αγωγό με την πάρoδο του χρόνoυ.

• Κατασκευαστικές  ατέλειες:  Ατέλειες  στην  κατασκευή του  αγωγoύ μπορεί  να  προκαλέσoυν

απρoσδόκητες στενώσεις.

 

Εικόνα 2.1. Ανοικτός αγωγός (www.engr.scu.edu, 2020)
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Τα αποτελέσματα της υδραυλικής στένωσης περιλαμβάνoυν:

• Αύξηση της  ταχύτητας  τoυ ρευστού:  Σύμφωνα με την εξίσωση συνέχειας,  η  ταχύτητα  τoυ

ρευστoύ αυξάνεται όταν η διατoμή του αγωγoύ μειώνεται.

• Αύξηση της υδραυλικής πίεσης: Η στένωση μπoρεί να οδηγήσει σε τoπική αύξηση της πίεσης

λόγω του φαινoμένου Venturi.

• Απώλειες  πίεσης:  Οι  απώλειες  πίεσης  αυξάνονται  λόγω  της  αυξημένης  τριβής  και  των

δυνάμεων πoυ προκύπτoυν από την αλλαγή της διατoμής.

Η κατανόηση της υδραυλικής στένωσης είναι σημαντική για τη σωστή διαχείριση και συντήρηση των

υδραυλικών συστημάτων, καθώς και για την επίλυση  πρoβλημάτων πoυ σχετίζoνται με τη ροή των

ρευστών σε αγωγoύς.

         

Εικόνα 2.2 Οχετοί (www.nomoskopio.gr)
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Oρισμένα παραδείγματα πoυ χρησιμοποιούν στένωση σε έναν ανoικτό αγωγό νερού είναι:

• Διαμέτρημα (διάφραγμα) σε μια βρύση ή βαλβίδα: Ορισμένες βρύσεις ή βαλβίδες έχoυν έναν

ελεγκτή που  μπoρεί να περιορίσει τη ροή του  νερoύ δημιουργώντας στένωση με τη ρύθμιση

του διαμετρήματoς.

• Στένωση σε ακρoφύσιο άρδευσης: Σε συστήματα άρδευσης, οι ακροφύσιοι μπoρούν να έχουν

διαφορετικά μεγέθη ανοίγματος για τη ρύθμιση της ρoής νερού και της πίεσης.

• Στένωση σε  στρoφή (ελλογιμότητα): Όταν τo νερό κινείται μέσα σε στροφές ή καμπύλες σε

έναν αγωγό, η ταχύτητα αυξάνεται και η πίεση μειώνεται. Μια στένωση σε μια στρoφή μπoρεί

να ρυθμίσει αυτήν την αλλαγή της ρoής και πίεσης.

• Κλειστό αντλητήρα: Σε ένα σύστημα αντλητήρα νερού, η  ρoή μπορεί να περιοριστεί με την

ρύθμιση της αντλίας, δημιουργώντας έτσι στένωση στoν αγωγό.

Εικόνα 2.3 Αντιπλημμυρικά Έργα Στο Αρτεσιανό (www.karditsanews.gr)
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2.2 Στένωση Venturi

Η  στένωση  Venturi  είναι  μια  διάταξη  που  προκαλεί  μετάβαση  μιας  ροής  ανοικτού  αγωγού  από

υποκρίσιμη σε υπερκρίσιμη κατάσταση. Αυτό επιτυγχάνεται με σταδιακή ελάττωση και στη συνέχεια,

σταδιακή αύξηση του πλάτους του αγωγού. Δημιουργείται έτσι  μια περιοχή ελαχίστου πλάτους,  η

οποία αποτελεί το κύριο χαρακτηριστικό αυτής της διάταξης (Σχήμα α).  Σε ορισμένες παραλλαγές

αυτής  της  βασικής  μορφής,  η  στένωση  της  διατομής  συνδυάζεται  με  ανύψωση  του  πυθμένα.  Η

μετάβαση της  ροής  από υποκρίσιμη ανάντι  της  στένωσης,  σε υπερκρίσιμη κατάντι  της  στένωσης,

συνεπάγεται εμφάνιση κρίσιμης ροής εντός της στένωσης, με ανάλογο κρίσιμο βάθος (Σχήμα β). 

Εικόνα 2.4 Η ροή διαμέσου στένωσης Venturi. (α) κάτοψη, (β) πλάγια όψη. (https://docplayer.gr)
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ΚΕΦΑΛΑΙΟ 3: HEC-RAS

3.1 Θεωρητική περιγραφή

Το πρόγραμμα HEC-RAS είναι ένα χρήσιμο εργαλείο για την αντιμετώπιση υδραυλικών ζητημάτων,

με πολλές εκδόσεις που επιτρέπουν στον χρήστη να προσομοιώνει φυσικά υδατικά φαινόμενα και να

υπολογίζει συνθήκες μονοδιάστατης και δισδιάστατης σταθερής ροής. Η ανάπτυξή του έγινε από το

σώμα  μηχανικών  του  Στρατού  των  Ηνωμένων  Πολιτειών,  το  Army  Corps  of  Engineers.  Στην

συγκεκριμένη πτυχιακή εργασία το λογισμικό που χρησιμοποιείται είναι η έκδοση 6.4.1. Επιλέχθηκε

αυτό  το  πρόγραμμα,  γιατί  προσφέρεται  δωρεάν,  είναι  πολύ  γρήγορο  λόγω  της  μονοδιάστατης

λειτουργίας  του  και  παράλληλα  πολύ  εύχρηστο,  πράγμα  το  οποίο  είναι  ζωτικής  σημασίας  για

οποιονδήποτε χρήστη. Συγκεκριμένα, πρόκειται για ένα λογισμικό υδραυλικής ανάλυσης που επιτρέπει

στο χρήστη να εντοπίζει πιθανές περιοχές πλημμύρας, να εκτιμά υδραυλικές κατασκευές, να σχεδιάζει

διαφορετικές  δομές  και  να  πραγματοποιεί  υδραυλικούς  υπολογισμούς  σε  ανοικτούς και  κλειστούς

αγωγούς. Επιπρόσθετα, η εφαρμογή του προγράμματος σε οποιοδήποτε πρόβλημα θεωρεί ότι η ροή

είναι  σταθερή,  μονοδιάστατη  και  μεταβάλλεται  σταδιακά.  Όπως  αναφέρθηκε  παραπάνω,  στους

ανοικτούς αγωγούς η ροή είναι  σταθερή,  χωρίς  εξάρτηση από τον χρόνο,  επομένως ο χρόνος δεν

λαμβάνεται υπόψη στην εξίσωση ενέργειας. Επιπλέον, η εξίσωση της συνολικής ενέργειας υποθέτει ότι

η τελική ενέργεια είναι η ίδια σε όλα τα σημεία της διατομής, προκαλώντας μια μονοδιάστατη ροή και

τέλος  η  εξίσωση  ενέργειας  θεωρεί  την  κατανομή  της  πίεσης  ως  υδροστατική  σε  κάθε  διατομή,

επομένως η ροή μεταβάλλεται βαθμιαία. Επιπλέον, για να υλοποιηθεί το πρόγραμμα απαιτείται να

είναι οι κλίσεις της κοίτης μικρότερες από το 1:10. Έτσι, αναφερόμαστε σε ένα υδρολογικό μοντέλο

που παρέχει έναν όγκο πληροφοριών σχετικά με τη μελέτη ενός έργου που εξετάζεται σε συγκεκριμένο

χρονικό σημείο. Η πληροφορίες για ένα έργο περιλαμβάνουν λεπτομερείς πληροφορίες για το έργο, τα

γεωμετρικά του χαρακτηριστικά, τις μόνιμες και μη μόνιμες ροές, καθώς και τα υδραυλικά στοιχεία. 

3.2 Βασικές εξισώσεις του προγράμματος

Το πρόγραμμα HEC-RAS για τον τρόπο υπολογισμού μιας υδραυλικής μελέτης στηρίζεται σε κάποιες

βασικές εξισώσεις της υδραυλικής όπως:
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3.2.1 Εξίσωση Manning

Η εξίσωση Manning χρησιμοποιείται για τον υπολογισμό της ελεύθερης επιφάνειας του νερού κατά

μήκος του αγωγού, προσδιορίζει το συσχετισμό ανάμεσα στην τραχύτητα της επιφάνειας, την παροχή,

τη γεωμετρία της ροής και τον ρυθμό απωλειών τριβής, για συγκεκριμένο σημείο του ρέματος. Στο

υδρολογικό  μοντέλο  HEC-RAS  για  να  υπολογιστούν  οι  παροχές  και  τα  υδραυλικά  στοιχεία  της

διατομής, υποδιαιρείται η υπάρχουσα διατομή στην κεντρική κοίτη και στις χειμαρρικές ζώνες μέσω

της  αλλαγής  του  συντελεστή  τραχύτητας  του  Manning.  Η  συνολική  παροχή  Q  προκύπτει  ως  το

άθροισμα των αντίστοιχων των επιμέρους τμημάτων των διατομών, άρα η εξίσωση Manning δίνεται

από την σχέση : 

Q=1
n
×A×R2/3×Sf

1/2                                                                                                                          (1)

 
όπου, 

n ο συντελεστής τραχύτητας Manning 

Q η παροχή

A η επιφάνεια του νερού 

R η υδραυλική ακτίνα 

Sf η κλίση απωλειών τριβής  

3.2.2 Η εξίσωση ενέργειας 

Κάποιοι  υπολογισμοί  που  πρέπει  να  κάνει  το  πρόγραμμα  βασίζονται  στην  επίλυση  της  εξίσωσης

ενέργειας  που  ισχύει  για  το  τμήμα  μεταξύ  δύο  διαδοχικών  διατομών,  σε  συνθήκες  βαθμιαίας

μεταβαλλόμενης ροής, σε συσχετισμό με την εξίσωση Manning για την αποτίμηση της κλίσης της

γραμμής ενέργειας .

 Η τελική εξίσωση διατήρησης της ενέργειας δίνεται από την σχέση:

 WS2+a2 ×
V 2

2

2g
=WS1+a1 ×

V 1
2

2g
+hf +ho                                                                                               (2)

όπου: 

WS η ανώτατη στάθμη νερού σε σχέση με το επίπεδο αναφοράς 

V η μέση ταχύτητα ροής
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a1, a2 σταθμικοί συντελεστές της ταχύτητας 

g η επιτάχυνση της βαρύτητας 

hf απώλειες λόγω τριβής 

ho απώλειες λόγω στενώσεων και διευρύνσεων 

Επίσης, δεν μπορούν να λείπουν και οι απώλειες ενέργειας λόγω της τριβής, οι οποίες δίνονται από την

σχέση: 

hf =L∗ Sf                                                                                                                                           (3)

όπου,

L το μήκος της κοίτης μεταξύ των διατομών 

Sf η μέση κλίση της γραμμής της ενέργειας 

Επιπρόσθετα, οι απώλειες σε μια απότομη αλλαγή της ροής εξαιτίας των διακυμάνσεων του πλάτους

και του μήκους αλλά και του βάθους της κοίτης υπολογίζονται από τη σχέση :

h0=c∗|a1×
V 1

2

2 g
−a2×

V 2
2

2 g
|                                                                                                                  (4)

 όπου c ο συντελεστής συστολής ή διαστολής (0.3 και 0.1 αντίστοιχα) 

Το μήκος L της κοίτης μεταξύ των διατομών υπολογίζεται από την σχέση: 

L=
LlobQlob+LchQch+LrobQrob

Qlob+Qch+Qrob

                                                                                                            (5)

όπου, Llob, Lch, Lrob τα μήκη της αρχικής και της τελικής πλημμυρικής ζώνης και της κεντρικής

κοίτης, και Qlob, Qch, Qrob οι μέσες παροχές ανά τμήμα κάθε διατομής. 

3.2.3 Εξίσωση συνέχειας 

Η  εξίσωση  συνέχειας  μπορεί  να  χρησιμοποιηθεί  για  τον  υπολογισμό  του  ρυθμού  των  απωλειών

ενέργειας λόγω τριβής, μεταξύ αλλεπάλληλων διατομών, σε συνδυασμό πάντα με την εξίσωση του

Manning. Η εξίσωση συνέχειας δίνεται από την σχέση :
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 Q=V 1× A1=V 2× A2                                                                                                                          (6)

 Επίσης, η κλίση απωλειών τριβής σε μια διατομή μπορεί να υπολογιστεί εάν λύσουμε την εξίσωση

h0=c∗|a1×
V 1

2

2 g
−a2×

V 2
2

2 g
|                                                                                                                  (7)

ως προς Sf . 

Συνεπώς η εξίσωση θα γίνει: 

Sf=( nQ
AR2/3 )

2

                                                                                                                                       (8)

3.2.4 Εξίσωση διατήρησης της ορμής 

Η εξίσωση αυτή όσον αφορά το πρόγραμμα HEC-RAS χρησιμοποιείται σε περιπτώσεις υδραυλικού

άλματος, και σε διασταυρώσεις υδατορευμάτων, όπου σε αυτές τις περιπτώσεις η ροή αλλάζει απότομα

κατάσταση και γίνεται υπερκρίσιμη. Επιπλέον, η σχέση της εξίσωσης της διατήρησης της ορμής είναι

αποτέλεσμα του 2 ου νόμου του Νεύτωνα που είναι  ΣFx=m∗a , όπου  η συνισταμένη των𝚺𝐅𝐱

δυνάμεων,  η μάζα και  η επιτάχυνση. Εφαρμόζοντας λοιπόν, το νόμο του Νεύτωνα στον όγκο𝐦 𝐚

νερού που περιβάλλεται ανάμεσα των διατομών 1 και 2, η μεταβολή της ορμής στη μονάδα του χρόνου

δίνεται από την σχέση:

P2 − P1+W x − F f=Q× ρ × DV x                                                                                                           (9)

όπου, 

P η υδροστατική πίεση στις διατομές 1 και 2 

Wx η δύναμη από το βάρος του νερού στη διεύθυνση x 

Ff η δύναμη τριβής ανάμεσα στις διατομές 1 κα 2 

Q η παροχή 

ρ η πυκνότητα του νερού 

DVx η μεταβολή της ταχύτητας 
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ΚΕΦΑΛΑΙΟ 4: ΜΕΘΟΔΟΛΟΓΙΑ 

Σε αυτό το κεφάλαιο θα παρουσιαστούν τα υδραυλικά δεδομένα που λήφθηκαν υπόψη για την μελέτη

του σεναρίου και η μεθοδολογία χρήσης του προγράμματος. 

4.1 Δεδομένα

Η συγκεκριμένη διπλωματική εργασία όπως προαναφέρθηκε παραπάνω, ασχολείται  με την μελέτη

ενός  ανοικτού  ορθογωνίου  αγωγού  μεγάλης  κλίμακας  και  όπως  είναι  φυσιολογικό  έχουν  ληφθεί

κάποιες παραδοχές και δεδομένα. Συγκεκριμένα, μελετήθηκε η περίπτωση στένωσης ενός ανοικτού

ορθογωνίου αγωγού μήκους 100m, με τις διατομές να ξεκινάνε στα  100m, στη συνέχεια  στα 60m, στα

55m, στα 45m, στα 40m και να καταλήγουν στα 0m. Αντίστοιχα μελετήθηκε στένωση σε αγωγό 700m

καθώς και το σενάριο τριών διαδοχικών στενώσεων σε αγωγό 700m.

Ο  συντελεστής  Manning  θεωρήθηκε  ίδιος  με  τιμή  0.01.  Επιπλέον,ο  αγωγός  έχει  μία  κλίση

3‰ ,ομοιόμορφο βάθος ροής 0,0003, η παροχή είναι  1m3/s καθώς και, οι συντελεστές συστολής

και  διαστολής  θεωρήθηκαν  σε  όλες  τις  διατομές  ίδιοι  με  0.1  και  0.3  αντίστοιχα,  παρόλο  που  οι

συντελεστές μπορεί να μεταβάλλονται είτε απότομα είτε σταδιακά, ανάλογα με τη διατομή, αλλά στην

περίπτωση μας θεωρήθηκε ότι υπάρχουν σταδιακές μεταβολές. 

4.2 Μεθοδολογία του λογισμικού 

Το περιβάλλον εργασίας του HEC-RAS 6.4.1 απεικονίζεται στο (Εικόνα 4.1). 

Εικόνα 4.1 Περιβάλλον εργασίας HEC-RAS 6.4.1
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Αρχικά, πριν ξεκινήσει η διαδικασία εισαγωγής δεδομένων, είναι αναγκαίο να ελεγχθεί εάν οι μονάδες

μέτρησης βρίσκονται στο Διεθνές Σύστημα Μονάδων ( SI  Units) (Σχήμα 4.1).Στη  συνέχεια ακολουθεί

η δημιουργία ενός new project στην επιλογή file, στο οποίο θα αποθηκευτεί η όλη διαδικασία μελέτης

της στένωσης του αγωγού μέσω του προγράμματος. Έπειτα, από την επιλογή Edit και στην συνέχεια

στο Geometric  Data,  αμέσως  μετά  το  εικονίδιο  River  reach για  να  σχεδιαστεί  το  σκαρίφημα της

κάτοψης του αγωγού και πατώντας διπλό κλικ στο τέλος του σχεδιασμού να εμφανιστεί το εικονίδιο

ονομασίας του (Σχήμα 4.2).  

Εικόνα 4.2 Σχεδιασμός σκαριφήματος. 

Στη συνέχεια, επιλέγεται το εικονίδιο Cross Section για να ξεκινήσει η εισαγωγή των γεωμετρικών

δεδομένων των διατομών στο λογισμικό για καθεμία ξεχωριστά  κλικάροντας στο Options το Add a

new Cross Section. Μετέπειτα, επιλέγονται οι συντεταγμένες της κάθε διατομής, για να τοποθετηθεί το

κατάντι μήκος ανά διατομή (Downstream Reach Length). Στη συνέχεια εισάγονται οι αποστάσεις της

δεξιάς/αριστερής όχθης και κεντρικής κοίτη και τέλος ο συντελεστής Manning και οι συντελεστές

συστολής/ διαστολής, όπως φαίνεται και στην εικόνα 4.3
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Εικόνα 4.3 Εισαγωγή γεωμετρικών στοιχείων των διατομών. 

Τελειώνοντας αυτά τα  στάδια πατώντας Apply Data εμφανίζεται  η διαμόρφωση της διατομής.  Η

διαδικασία παραμένει ίδια και για τις υπόλοιπες διατομές του αγωγού επιλέγοντας το Options →  Add

a new Cross Section ή με το Options → Copy Current Cross Section για εξοικονόμηση χρόνου. Αφού

τελειώσει  η  διαδικασία  στο  Cross  Section  Data  με  το  τρέξιμο  των  διατομών,  είναι  αναγκαία  η

αποθήκευση της File → Save Geometry Data. 

Επόμενο βήμα είναι  η εισαγωγή των υδρολογικών δεδομένων που βρίσκεται στο αρχικό περιβάλλον

του προγράμματος στην επιλογή  Edit→ Steady flow data  όπου εμφανίζεται το παρακάτω παράθυρο

(Εικόνα 4.4)

Εικόνα 4.4 Steady Flow Data
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Η  παροχή  που  εξετάζεται  είναι Q=1
m3 /s .Επίσης,  γίνεται  εισαγωγή  οριακών  συνθηκών  (  Reach

Boundary Conditions ), όπου θα οριστούν ως ομοιόμορφο βάθος ( Normal Depth ). 

        

Εικόνα 4.5 Εισαγωγή οριακών συνθηκών 

Εν συνεχεία, είναι η προετοιμασία των υδραυλικών υπολογισμών, επιλέγοντας μόνιμη και μικτή ροή. 

                             

Εικόνα 4.6 Επιλογή μικτής ροής 

Τέλος, πατώντας Compute εμφανίζεται μήνυμα για την επιτυχή ολοκλήρωση της προσομοίωσης. 
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ΚΕΦΑΛΑΙΟ 5: ΑΠΟΤΕΛΕΣΜΑΤΑ 

Στο παρόν κεφάλαιο παρουσιάζονται αναλυτικά τα δύο σενάρια ομοιόμορφης ροής ανοικτού αγωγού

ορθογωνικής διατομής,  ένα των 100m  και  ένα των 700m  αντίστοιχα  ,  ακόμη δύο σενάρια με την

τοπική στένωση των παραπάνω αγωγών καθώς και ένα ακόμη σενάριο στο οποίο πραγματοποιούνται

τρεις διαδοχικές στενώσεις πάνω στο μοντέλο του αγωγού των 700m.

5.1 1ο Σενάριο (αγωγός ορθογωνικής διατομής 100m)

Στο συγκεκριμένο σενάριο έχουμε έναν απλό ανοικτό αγωγό  100m ορθογωνικής διατομής 1m˟1,5m

παροχής  Q=1
m3 /s ,  συντελεστή  τραχύτητας  Manning  n=0,01  και  ομοιόμορφης  κλίσης

S=0,3‰.Στόχος  του  συγκεκριμένου  σεναρίου  είναι  ο  υπολογισμός  του  κανονικού  ομοιόμορφου

βάθους ροής y.

                         

Εικόνα 5.1.1 Κάτοψη αγωγού

Λύση με μονοδιάστατη ανάλυση :

A⋅Rh2/3=n⋅Q
S1/2 ⇒ A⋅Rh2/3=0,578 [1]                                                                                                 (10)

{ A=b⋅y
p=b+2 y}⇒ Rh=A / p= b⋅y

b+2 y
[2]                                                                                                (11)

[1]⇒
[2]

y⋅( y
1+2 y

)
2/3

=0,578                                                                                                                 (12)

με τη χρήση δοκιμών, 

αν y=1 το αποτέλεσμα είναι 0,48 < 0,578 
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αν y=2 το αποτέλεσμα είναι 1,0857 > 0,578 

αν y=1,165 το αποτέλεσμα είναι 0.578 = 0,578

Επομένως το κανονικό βάθος ροής είναι y=1,165

Λύση μέσω προγράμματος:

   

          

Εικόνα 5.1.2 Geometric Data

          

Εικόνα 5.1.2 Διατομή 1
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Εικόνα 5.1.3 Διατομή 2

         

Εικόνα 5.1.4 Διατομή 3
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Εικόνα 5.1.5 Διατομή 4

          

Εικόνα 5.1.6 Διατομή 5

27



          

Εικόνα 5.1.7 Διατομή 6

Στις παραπάνω απεικονίσεις  βλέπουμε τις διατομές και τα στοιχεία τους, τα οποία είναι η στάθμη του

ύδατος (μπλε γραμμή), η γραμμή ενέργειας (πράσινη διακεκομμένη γραμμή) και το κρίσιμο βάθος

(κόκκινη διακεκομμένη γραμμή).

Εικόνα 5.1.8 Steady Flow Data
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Εικόνα 5.1.9 Ορισμός ομοιόμορφης ροής

Στις εικόνες 5.8 και 5.9 βλέπουμε την εισαγωγή της παροχής Q=1m3/s και την κλίση της ομοιόμορφης

ροής S=0,0003. Στη συνέχεια ορίζουμε την ροή σε μικτή.

          

Εικόνα 5.1.10 Ορισμός μικτής ροής
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Εικόνα 5.1.11 Πλάγια όψη του συνολικού τμήματος με αποτύπωση της γραμμής ενέργειας (EG), της
επιφάνειας του ρευστού (WS), του κρίσιμου βάθους (Crit) και του πυθμένα (Ground) για παροχή 
Q = 1 m3 /s. 

         

Εικόνα 5.1.12 Τρισδιάστατο σκαρίφημα υδατορεύματος 
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Εικόνα 5.1.13 Στοιχεία διατομών 

Για τον υπολογισμό του ομοιόμορφου βάθους ροής διαιρούμε το  Flow Area  με το  Top Width  και

βλέπουμε  πως   y=1,16/1=1,16m.  Παρατηρούμε  ότι  η  γραμμή  ενέργειας  ξεκινάει  στα  1.23m  και

καταλήγει στα 1.20m ενώ η ταχύτητα κυμαίνεται στα 0.86 m/s.

5.2 2ο Σενάριο (στένωση αγωγού ορθογωνικής διατομής 100m) 

Σε αυτό το σενάριο γίνεται μία τοπική στένωση στον παραπάνω αγωγό 100m όπου στα 60m από το 

τέλος του αγωγού ξεκινάει η στένωση μέχρι τα 55m, η ροή συνεχίζει μέχρι τα 45m και στη συνέχεια 

επιστρέφει στις κανονικές του διαστάσεις στα 40m. Αυτός ο ανοικτός αγωγός μήκους 100 m είναι 

ορθογωνικής διατομής 1m x 1,5m πριν και μετά τη στένωση ενώ κατά τη διάρκειά της η διατομή είναι 

0,5m x 1,5m. Η παροχή είναι Q=1m3/s , με συντελεστή τραχύτητας Manning n = 0,01 και ομοιόμορφης

κλίσης S = 0,3 ‰.

31



 

          

 Εικόνα 5.2.2 Geometric Data
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 Εικόνα 5.2.1 Κάτοψη αγωγού (ροή από δεξιά προς τα αριστερά)



Εικόνα 5.2.3 Διατομή 1

Εικόνα 5.2.4 Διατομή 2
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Εικόνα 5.2.5 Διατομή 3

Εικόνα 5.2.6 Διατομή 4
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Εικόνα 5.2.7 Διατομή 5

          

Εικόνα 5.2.8 Διατομή 6

Στη συνέχεια από το  Geometric Data → Tools → XS Interpolation → Between 2 XS’s  ορίζω πόσες

διατομές θα εισαχθούν στο παρών μοντέλο.
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Εικόνα 5.2.9 Interpolation Between 2 XS’s

Από τα σημεία 0 έως 40 και 60 έως 100 ορίζω διατομές ανά 1m, ενώ από το σημείο 40 έως 60 ορίζω

διατομές ανά 0,1m. Η παροχή και η κλίση ομοιόμορφης ροής παραμένουν ίδιες καθώς και ο ορισμός

της ροής σε μικτή.

          

Εικόνα 5.2.10  Πλάγια όψη του συνολικού τμήματος
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Τα υπόλοιπα βήματα παραμένουν ίδια με του Σεναρίου 1. Στις παρακάτω εικόνες παρατηρούμε το

βάθος ροής με το οποίο διέρχεται η ροή από τη στένωση.

  

Εικόνα 5.2.11 Στοιχεία διατομών από 60-56,9
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Εικόνα 5.2.12 Στοιχεία διατομών από 56,8-53,7
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Εικόνα 5.2.13 Στοιχεία διατομών από 53,6-50,5
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Εικόνα 5.2.14 Στοιχεία διατομών από 50,4-47,3
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Εικόνα 5.2.15 Στοιχεία διατομών από 47,2-44,1
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Εικόνα 5.2.16 Στοιχεία διατομών από 44-40
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Παρατηρούμε ότι στη διατομή 45,1 το βάθος ροής y βρίσκεται στο χαμηλότερο σημείο καθώς 

y=Flow Area / Top Width= 0,5372 / 0,5 = 1,0744m < 1,16m (Σενάριο 1). Επίσης η γραμμή ενέργειας

ξεκινάει στα 1.32m και καταλήγει στα 1.20m. Όσο αφορά την ταχύτητα, ξεκινάει στα 0.80 m/s, 

στη συνέχεια επιταγχύνει καθώς αρχίζει η στένωση φτάνοντας μέχρι και τα 1.86 m/s και στη συνέχεια

μειώνεται στην επιστροφή των κανονικών διαστάσεων του αγωγού και καταλήγει στα 0.86 m/s.

          

Εικόνα 5.2.17 Στοιχεία διατομών

Λύση με μονοδιάστατη ανάλυση :

Q=V 1⋅A1⇒V 1=
1

1×1,165
⇒V 1=0,86m/ s                                                                                      (13)

q2=
Q
b2

=2m3/ s⋅m                                                                                                                              (14)

q1=
Q
b1

=1m3/s⋅m                                                                                                                              (15)

Βρίσκω Emin
(1)

= y
(1)

c+
V C

(1)
2

2g
                                                                                                                  (16)

y
(1)

c=
3√ q1

2

g
=0,467 m                                                                                                                           (17)

V
(1)

c=√g⋅y
(1)

c=2,14 m/ s                                                                                                                       (18)

Άρα Emin
(1)

=0,7m                                                                                                                              (19)
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Βρίσκω Emin
(2)

= y
(2)

c+
V C

(2)
2

2g
                                                                                                                  (20)

y
(2)

c=
3√ q2

2

g
=0,742m                                                                                                                           (21)

V
(2)

c=√g⋅y
(2)

c=2,698 m /s                                                                                                                     (22)

Άρα Emin
(2)

=1,113 m                                                                                                                          (23)

Το y1=1,165m (από Σενάριο 1)

Οπότε E1= y1+
V 1

2

2 g
=1,203 m                                                                                                            (24)

Θεωρώ ότι δεν έχω απώλειες ενέργειας κατά τη μετάβαση της ροής από τη διατομή 1 στη διατομή 2

άρα ισχύει E1=E2

Βρίσκομαι στη πρώτη περίπτωση όπου  Ε1=1,203 m>Emin
(2)

=1,113m

Επομένως η ευθεία  E1 τέμνει τη καμπύλη E2 και για τον υπολογισμό του βάθους ροής y2 στη διατομή 2

έχω:

E2=1,203= y2+
q2

2

2⋅g⋅y2
2
⇒1,203= y2+

0,204

y2
2                                                                                    (25)

Υπολογίζω τον αριθμό Fr της ροής στη διατομή 1

Fr1=
V 1

V
(1)

c

=0,402<1 άρα υποκρίσιμη ροή                                                                                         (26)

Θα πρέπει y=1,165m> y2 > y2
(2)=0,742m
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Δοκιμές : 

για y2=1m έχω 1,203 = 1,204

για y2=0.9m έχω 1,203 = 1,152

για y2=0,9985 έχω 1,203 = 1,203

Επομένως  το  βάθος  ροής στη  στένωση είναι  y=  0,9985  (μικρή  σχετικά  απόκλιση  με  αυτή  του

προγράμματος y=1,0744m)

5.3 3ο Σενάριο (αγωγός ορθογωνικής διατομής 700m)

Στο παρακάτω σενάριο  έχουμε έναν  απλό  ανοικτό  αγωγό  700m ορθογωνικής διατομής  1mΧ1,5m
ομοιόμορφης ροής διατομής, παροχής Q=1m3/s , με συντελεστή τραχύτητας Manning n = 0,01 και
ομοιόμορφης κλίσης S = 0,3 ‰.
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Εικόνα 5.3.1 Κάτοψη αγωγού



          

Εικόνα 5.3.1 Geometric Data

Εικόνα 5.3.2 Διατομή 1
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Εικόνα 5.3.3 Διατομή 2

Στη συνέχεια από το  Geometric Data → Tools → XS Interpolation → Within a Reach  ορίζω πόσες

διατομές θα εισαχθούν στο παρών μοντέλο. Στη προκειμένη περίπτωση ορίστηκαν διατομές ανά 10m.

Τα υπόλοιπα βήματα παραμένουν ίδια με του Σεναρίου 1.

          

Εικόνα 5.3.4 Πλάγια όψη συνολικού τμήματος
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Εικόνα 5.3.5 Στοιχεία διατομών από 700-390
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Εικόνα 5.3.6 Στοιχεία διατομών από 310-0

Για τον υπολογισμό του ομοιόμορφου βάθους ροής διαιρούμε το  Flow Area  με το  Top Width  και

βλέπουμε πως   y=1,1632/1=1,1632m.  Παρατηρούμε ότι η γραμμή ενέργειας ξεκινάει στα 1.41m και

καταλήγει στα 1.20m. Η ταχύτητα κυμαίνεται στα 0.86 m/s.

49



5.4 4ο Σενάριο (στένωση αγωγού ορθογωνικής διατομής 700m)

Σε αυτό το σενάριο γίνεται μία τοπική στένωση στον παραπάνω αγωγό 700m όπου στα 400m από το

τέλος του αγωγού ξεκινάει η στένωση μέχρι τα 375m, η ροή συνεχίζει μέχρι τα 325m και στη συνέχεια

επιστρέφει στις κανονικές του διαστάσεις στα 300m. Ο παρών αγωγός μήκους 700m ορθογωνικής

διατομής είναι  1mΧ1,5m πριν  και  μετά τη στένωση ενώ κατά τη διάρκειά  της  η  διατομή γίνεται

0,5mΧ1,5m. Η παροχή είναι Q=1m3/s , με συντελεστή τραχύτητας Manning n = 0,01 και ομοιόμορφης

κλίσης S = 0,3 ‰.

   

Εικόνα 5.4.1 Κάτοψη αγωγού  ( Η ροή ξεκινάει από τα δεξιά )
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Εικόνα 5.4.2 Geometric Data

Εικόνα 5.4.3 Διατομή 1
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Εικόνα 5.4.4 Διατομή 2

Εικόνα 5.4.5 Διατομή 3
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Εικόνα 5.4.6 Διατομή 4

Εικόνα 5.4.7 Διατομή 5
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Εικόνα 5.4.8 Διατομή 6

Στη συνέχεια από το Geometric Data → Tools → XS Interpolation → Between 2 XS’s ορίζω πόσες

διατομές θα εισαχθούν στο παρών μοντέλο. Από τα σημεία 0 έως 300 και 400 έως 700 ορίζω διατομές

ανά 10m, ενώ από το σημείο 300 έως 400 ορίζω διατομές ανά 1m. 

Η παροχή και η κλίση ομοιόμορφης ροής παραμένουν ίδιες καθώς και ο ορισμός της ροής σε μικτή. Τα

υπόλοιπα βήματα παραμένουν ίδια με του Σεναρίου 1.

           

Εικόνα 5.4.9 Πλάγια όψη συνολικού τμήματος
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Εικόνα 5.4.10 Στοιχεία διατομών από 400-369
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Εικόνα 5.4.11 Στοιχεία διατομών από 368-337
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Εικόνα 5.4.12 Στοιχεία διατομών από 336-300

Παρατηρούμε ότι στη διατομή 325 το βάθος ροής y βρίσκεται στο χαμηλότερο σημείο καθώς 

y=Flow Area / Top Width= 0,5446/ 0,5 = 1,0892m < 1,1632m (Σενάριο 3). Επίσης η γραμμή ενέργειας

ξεκινάει  στα  1.57m  και  καταλήγει  στα  1.20m.Η  ταχύτητα  ξεκινάει  στα  0.75  m/s,  στη  συνέχεια

επιταχύνει καθώς αρχίζει η στένωση φτάνοντας μέχρι και τα 1.84 m/s και στη συνέχεια μειώνεται στην

επιστροφή των κανονικών διαστάσεων του αγωγού και καταλήγει στα 0.86 m/s.
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Εικόνα 5.4.13 Στοιχεία διατομών

5.5 5ο Σενάριο (3 διαδοχικές στενώσεις αγωγού ορθογωνικής διατομής 700m)

Σε αυτό το σενάριο γίνονται τρεις διαδοχικές στενώσεις στον αγωγό των 700m του Σεναρίου 3 όπου

στα 600m από το τέλος του αγωγού ξεκινάει η στένωση μέχρι τα 575m, η ροή συνεχίζει μέχρι τα 525m

και στη συνέχεια επιστρέφει στις κανονικές του διαστάσεις στα 500m. Η ίδια ακολουθία εφαρμόζεται

στα 400m και στα 200m. O αγωγός έχει ορθογωνική διατομή 1mΧ1,5m πριν και μετά τις στενώσεις

ενώ κατά τη διάρκειά τους η διατομή γίνεται 0,5mΧ1,5m. Η παροχή είναι Q=1m3/s , με συντελεστή

τραχύτητας Manning 

n = 0,01 και ομοιόμορφης κλίσης S = 0,3 ‰.

Εικόνα 5.5.1 Κάτοψη αγωγού  ( Η ροή ξεκινάει από τα δεξιά )

58



          

Εικόνα 5.5.2 Geometric Data

Εικόνα 5.5.3 Διατομή 1
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Εικόνα 5.5.4 Διατομή 2

Εικόνα 5.5.5 Διατομή 3
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Εικόνα 5.5.6 Διατομή 4

Εικόνα 5.5.7 Διατομή 5
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Εικόνα 5.5.8 Διατομή 6

Εικόνα 5.5.9 Διατομή 7
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Εικόνα 5.5.10 Διατομή 8

Εικόνα 5.5.11 Διατομή 9
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Εικόνα 5.5.12 Διατομή 10

Εικόνα 5.5.13 Διατομή 11

64



         

Εικόνα 5.5.14 Διατομή 12

Εικόνα 5.5.15 Διατομή 13
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Εικόνα 5.5.16 Διατομή 14

Στη συνέχεια από το  Geometric Data → Tools → XS Interpolation → Between 2 XS’s  ορίζω πόσες

διατομές θα εισαχθούν στο παρών μοντέλο. 

Από τα σημεία 0 έως 100, 200 έως 300, 400 έως 500 και 600 έως 700 ορίζω διατομές ανά 10m, ενώ

από τα σημεία 100 έως 200, 300 έως 400 και 500 έως 600 ορίζω διατομές ανά 1m. Η παροχή και η

κλίση ομοιόμορφης ροής παραμένουν ίδιες καθώς και ο ορισμός της ροής σε μικτή.

       

Εικόνα 5.5.17 Πλάγια όψη συνολικού τμήματος
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Εικόνα 5.5.18 Στοιχεία διατομών από 600-569
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Εικόνα 5.5.19 Στοιχεία διατομών από 568-525
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Εικόνα 5.5.20 Στοιχεία διατομών από 524-500
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Εικόνα 5.5.21 Στοιχεία διατομών από 375-325
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Εικόνα 5.5.22 Στοιχεία διατομών από 324-300

Εικόνα 5.5.23 Στοιχεία διατομών από 175-144
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Εικόνα 5.5.24 Στοιχεία διατομών από 143-100
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Παρατηρούμε ότι η γραμμή ενέργειας ξεκινάει στα 1.79m και καταλήγει στα 1.20m. Το χαμηλότερο

βάθος  ροής  της  1ης  Στένωσης  είναι  1.4188m  (Flow  Area  /  Top  Width) στη  διατομή  525.  Το

χαμηλότερο βάθος ροής της 2ης Στένωσης είναι 1.292m στη διατομή 325. Το χαμηλότερο βάθος ροής

του  αγωγού  είναι  1.0892m  στη  διατομή  125.  Η  ταχύτητα  ξεκινάει  στα  0.64  m/s,  στη  συνέχεια

επιταγχύνει  καθώς  αρχίζει  η  πρώτη στένωση φτάνοντας  μέχρι  και  τα  1.41  m/s  και  στη  συνέχεια

μειώνεται στην επιστροφή των κανονικών διαστάσεων του αγωγού.

Η ίδια διαδικασία επαναλαμβάνεται στη 2η στένωση καθώς η ταχύτητα αυξάνεται μέχρι τα 1.55 m/s

(δεύτερη μεγαλύτερη ταχύτητα ροής αγωγού μετά τα 1.41 m/s) και στη συνέχεια μειώνεται.

Τέλος η ταχύτητα ροής του αγωγού φτάνει στην υψηλότερη τιμή του στην 3η στένωση καθώς φτάνει

μέχρι και τα 1.84 m/s και στην πορεία μειώνεται αφού ανοίγει ο αγωγός και πέφτει στα 0.86 m/s.
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Εικόνα 5.5.25 Στοιχεία διατομών



ΚΕΦΑΛΑΙΟ 8: ΣΥΜΠΕΡΑΣΜΑΤΑ

Στην παρούσα Διπλωματική Εργασία λοιπόν, επιλέχθηκαν δύο ανοικτοί αγωγοί ορθογωνικής διατομής

1x1,5m και μήκους 100 και 700 μέτρων, αντίστοιχα ώστε να μελετηθεί το βάθος ροής, η ταχύτητα και

η γραμμή ενέργειας πριν και στην περιοχή της στένωσης. Για την ανάλυση της ροής επιλέχθηκε ένα

πρόγραμμα  υδραυλικής  προσομοίωσης  το  HEC-RAS,  το  οποίο  παρέχει  μεγάλες  δυνατότητες  και

διευκολύνσεις. Με την ολοκλήρωση της προσομοίωσης και αφού λήφθηκαν υπόψη τα αποτελέσματά

της,  όπως  περιγράφονται  αναλυτικά  στο  προηγούμενο  κεφάλαιο,  προκύπτουν  τα  ακόλουθα

συμπεράσματα: 

• Στο πρώτο σενάριο ανοικτού αγωγού μήκους 100m, η ταχύτητα παρέμεινε σταθερή όπως και

το βάθος ροής. Η γραμμή ενέργειας μειωνόταν ομαλά.

• Στο  δεύτερο  σενάριο αγωγού μήκους 100m  με στένωση, η ταχύτητα αυξήθηκε κατά την

είσοδο  στη  στένωση του  αγωγού  και  στη  συνέχεια  μειώθηκε  κατά  την  έξοδό  της  όπου

παρατηρείται υδραυλικό άλμα. Η ταχύτητα μετά είναι μεγαλύτερη από την ταχύτητα πριν τη

στένωση. Το βάθος ροής μειώθηκε σημαντικά στη στένωση και στη συνέχεια κατέληξε στο

ίδιο  βάθος  ροής  του  πρώτου  σεναρίου  μετά  την  έξοδο  της.  Η  γραμμή  ενέργειας

αυξομειώθηκε σχετικά ομαλά.

• Στο τρίτο σενάριο αγωγού μήκους 700m, η ταχύτητα παρέμεινε σταθερή όπως και το βάθος

ροής. Η γραμμή ενέργειας είχε ήπια κλίση.

• Στο  τέταρτο  σενάριο  αγωγού μήκους 700m  με στένωση,  η ταχύτητα αυξήθηκε κατά την

είσοδο  στη  στένωση του  αγωγού  και  στη  συνέχεια  μειώθηκε  κατά  την  έξοδό  της  όπου

παρατηρείται υδραυλικό άλμα. Η ταχύτητα μετά είναι μεγαλύτερη από την ταχύτητα πριν τη

στένωση. Το βάθος ροής μειώθηκε σημαντικά στη στένωση και στη συνέχεια επέστρεψε στο

ίδιο βάθος ροής του τρίτου σεναρίου μετά την έξοδο της. Η γραμμή ενέργειας αυξομειώθηκε

σχετικά ομαλά.

• Στο  πέμπτο  σενάριο  αγωγού  μήκους  700m  με  τρεις  διαδοχικές  στενώσεις,  η  ταχύτητα

αυξήθηκε κατά την είσοδο στις στενώσεις του αγωγού και στη συνέχεια μειώθηκε κατά την

έξοδό  της  από  αυτές  όπου  παρατηρούνται  υδραυλικά  άλματα.  Η  ταχύτητα  μετά  είναι

μεγαλύτερη από την ταχύτητα πριν τις στενώσεις. Το βάθος ροής μειώθηκε σημαντικά στις

στενώσεις και στη συνέχεια κατέληξε στο ίδιο  βάθος ροής  του τρίτου σεναρίου μετά την

έξοδο της τελευταίας στένωσης. Η γραμμή ενέργειας αυξομειώθηκε σχετικά ομαλά .

• Γενικά στη στένωση επιταχύνεται η ροή του αγωγού και δημιουργείται ένα υδραυλικό άλμα.
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